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■ Operations Guide 

The following user guide explains how to operate the LS-RAPID system. Using this software, the 

user can simulate the initiation and motion of rapid landslides triggered by earthquakes (seismic 
loading) and rainfall (pore-water pressure). 
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■Operations Guide 

The following user guide explains how to operate the LS-RAPID system. Using this software, the 

user can simulate the initiation and motion of rapid landslides triggered by earthquakes (seismic 
loading) and rainfall (pore-water pressure). 

 

1. Introduction 
 

1.1. About LS-RAPID 
 
The LS-RAPID system is an application designed for Microsoft Windows based on the program, 

“Integrated model simulating the initiation and motion of rapid landslide initiation and motion” 
which produced by Dr. Kyoji Sassa (International Consortium on Landslides). The software uses a 

visual interface which enables the user to input topography parameters, sliding surface parameters, 
soil and water parameters, and landslide triggering factors (earthquakes and water pressure) to 

simulate the initiation and motion of landslides in 3D. It is designed to be easily operated by both 
experienced and first-time users.  

 

1.2. System Requirements 
 
The following are the minimum system requirements for running LS-RAPID. 

 
Operating System  Windows 7 / 8 / 10

Main Processor At least processor requirement for OS
Multi-Core processor (Example: Core2Duo) 

Main Memory Recommend 2GB RAM or greater

Hard Disk Drive 1GB free hard disk space or greater

Optical Drive CD-ROM (necessary for application setup)

Display Monitor 1024x768 pixels or greater

Mouse Mouse equipped with a scroll wheel

Video Card nVIDIA (GeForce) or ATI Technologies (RADEON) 
Note: LS-RAPID may not run on graphics cards other than the ones 
listed 

 

Note: Graphics cards other than the ones listed above may be incompatible (the display may become 
extremely slow). In that case: 

Go to [Property] from the screen  [Setting]  [Details]  [Troubleshooting]  

Choose [none] in Hardware accelerator.  
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1.3. Installation Instruction 
 
This section explains steps to install LS-RAPID. Once the CD of LS-RAPID is inserted into 

CD-ROM drive, the setup program will automatically launch. Click “Next” to start the installation.  

 

If do not wish to install the software to drive “C:”, then we can select the drive and folder where the 
software will be installed.  
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The following dialog box indicates that the installation has completed. Click “Finish” to complete 

the installation process. 
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If the LS-RAPID software is installed into computer for the first time, then it is important to install 
also the Sentinel Protection Installer (as shown in the boxes below), as the driver for the USB Key 

Protector, to ensure the LS-RAPID software works properly.  

 (The commands are unnecessary in a Trial Version) 

 

 

 

(New) 
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(Update)  
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1.4. Starting the LS-RAPID System 
 

To start the software, follow the steps below: 
Click [Start] [Programs]  [ICL]  [LS-RAPID]  

After the startup of LS-RAPID, the following window will appear. 

 

※The following initial screen will show both options of LS-RAPID and LS-Tsunami. Please choose 

the box of “LS-RAPID” in case of conducting the landslide simulation initially before doing tsunami 
simulation through “LS-Tsunami” (which is triggered by landslide). 
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Setting for the 
Topography Control 

Enter/Edit the Mesh Data  

and Load the Text File 

3(5)  

Enter/Edit the Control Point  

and Load the Text File 

3(3) 

Convert into Mesh Data by Estimating
the Topography from the Control Point 

 3(4) 

Setting the Control 
Point of the Sliding 

Surface? 

2. Simulation Flow Chart 
 

The following chart showing the holistic flow for landslide simulation using the LS-RAPID:  
(See more details in Chapter 3) 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
Continued on to the next page…. 

Start the Program  

Initialize the Topography Edition Settings 3(2) 

NO

YES 
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Enter/Edit the Control Point  
and Load the Text File 

3(3) 

Convert into the Mesh Data by Estimating 
the Topography from the Control Point  

3(4) 

Set the Ellipsoidal Parameters 3(6)

Set the Filling and the Excavation 3(7) 

3(6) Set the Sliding Surface using Ellipsoid and Section

3(7) Set the Attribute of Filling and Excavation 

Create the Mesh Data after completing the setting. 

Edit the Mesh Data of the Sliding Surface

Start Simulation  

Enter, Edit Mesh Data  
and Load the Text File 

3(5)  

Configure the necessary settings for the 
simulation 3(8) and Chapter 4 

Setting the Control Point 
of the Sliding Surface? 

 

 

  
 

 
 

 
 

 

 
 

 
 

 

 
 

 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

NO 

YES 

（Set the Ellipsoidal Parameters）

(Set the Filling/Excavation)
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3. Topography Edition 
 

3.1. Preparation of DEM Data 
(Skip this section if not necessary） 

 
Generally the DEMs are provided with a text file (X, Y, Z format) including Latitude, Longitude and 

Elevation. To input DEM data for LS-RAPID simulation, text file (X, Y, Z format) should be 
converted to elevation mesh data in advance. The accompanying software (DEMmake) is available 

to convert a text file to elevation mesh data. 
 

Open DEMmake (Excel file) and the following screen appears.  
(Macro feature should be enabled in advance.) 

 

 

(1) Click [Select Text-file] to select the text file which contains XYZ coordinates data like the 
following figure.  

  
*Three columns should be separated with blank or comma 
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(2) Click [Coordinate range information] and automatically the range of coordinate appears. 
In this case: 
The range of X is 5455651.502 ～ 5457651.502 
The range of Y is 5023253.883 ～ 5025773.883 

 
(3) Input the data of coordinate range gained by the previous operation into Grid cells. 

Pitch means the interval of X and Y coordinates. If we want to make Pitch bigger than original, 
input the interval necessarily, then the number of grids will be calculated automatically.  

When we have any designated coordinate point of the upper left and lower right of the simulation 
area within this range, we can input them as minimum and maximum points. 

*Do not input any number into the grey displayed cells 
 

In this case (full range): 
X min = 5455651.502   X max = 5457651.502   Pitch = 10   (Number of grids is 200.) 

Y min = 5023253.883   Y max = 5025773.883   Pitch = 10   (Number of grids is 252.) 
 

(4) Input the distance (m) from the grid point to reflect the arbitrary control point to a cell. 
This operation aims to set up the distance between the grid point and the arbitrary point to adopt Z 

value, when the distance between the nearest grid and the arbitrary point is less than the 
designated distance.    

 
If the distance is set up as 10.00 m: 

Case 1 
In the case that the grid point is (5455635.185, 5025800.000, -44.0), the nearest point is (X, Y) = 

(5455651.502, 5025773.883). In this case, Z value of this point, -44.0 is not adopted for the nearest 
point, because the horizontal distance is 30.795 m, bigger than 10.00 m. 

 
Case 2 
In the case that the grid point is (5455785.251, 5024215.957,-55.0), the nearest point is (X, Y) = 
(5455781.502, 5024213.883). In this case, Z value of this point, -55.0 is adopted for the nearest point, 

because the horizontal distance is 4.284 m, less than 10.00 m. 
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(5) Click [Generate DEM] and the generated DEM data are stored in the DEMdata sheet. 
*If there is no data near the grid point, the Z value at this point will not appear.  

In this case, the distance should be set up with a bigger value.  
 
Sample of the generated DEM data： 

 

 

(6) Choose the desired area to do simulation using the LS-RAPID. Then count the number of grids 
on X and Y. 

In this case, the numbers of grids are 8 on X, and 18 on Y. The number of grids minus 1 indicates 
the number of mesh at the setting of Calculation Area. The selected elevation mesh data can be 

copied and paste to the Slope Surface Elevation sheet. If we set up the area before generating DEM, 
the numbers of grids are calculated automatically. (See the next section) 
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3.2. Initial Setting of Topography Edition 
 

When the program has been started by creating a new document, there will be no topography data 
or settings appear for the simulation. This section explains the initial settings required to view 

topography.  
Click “Flow” panel on the left side of the window  then [1: Mesh] option  [Simulation area], or 

just click the [Simulation Area Setting] icon from the toolbar. The dialog of “Setting of simulation 
area and input-data type” then appears as follow,  

 

 

 
 
Item Description

Axial setting of simulation 
Area 

Enter the range for X-direction and Y-direction of the calculation 
area for the mesh.  
Range (-9999999.999～+9999999.999(m)) 

 
Mesh setting of simulation 
Area  

Enter the number of mesh and pitch in both X-direction and 
Y-direction of the mesh in the calculation area.  
The number of mesh ( 2～9999 ) 

Pitch (0.001～999999.999(m)) 

 

 
 

  



 

 
 

14

 
After setting the area then click “OK”, the following window will appear.  
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3.3. Editing the Topography Control Point 
(Skip this section if not necessary） 

 
If we wish to edit the topographic control point manually, select the required tab provided in the 

“Editing of Control Point” option that opened from the [Edit] menu as follows, 

 

If we already have a text file for the Control Point data, then from the [File] menu, select [Read text 
data file]  [Read (ground elevation・sliding surface elevation・sliding mass thickness) Control 

Point] to read the appropriate file.   

Note: The data in the text file should be separated by a space, tab, or comma (CSV format) to load 
correctly. Other text file formats may fail to load properly. 

 
After loading the text file and editing the data manually, the following window will appear. 
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3.4. Converting the Control Point Data into the Mesh Data by estimating the Topography  
(Skip this section if not necessary） 

Once the Control Point data has been edited (as explained in Section 3.3), the control point data can 

then be transferred into the mesh data. 
  

Go to [Menu]  [Edit]  [Transfer control point data to mesh data] 
 

After seeing the message in dialog box, the image of mesh topography with the reflected Control 
Point data will appear, indicating the converted process is done successfully.  

Note: After creating the Mesh data, we can still edit the Control Point. In this case, go back to the 
Edit the Control Point and then return to this section.  
 
 

3.5. Editing the Topography Mesh Data 

If we already have a text file for the Mesh data, from the [File] menu select the [Read text data file] 
option  then [Read (ground elevation・sliding surface elevation・sliding mass thickness）mesh 

data] and choose the appropriate file. 

After loading the text file and editing the data manually, we will see the following window. 

 
  



 

 
 

17

The calculation area can be edited with mesh data unit. If we wish to edit the values of Mesh data 

manually, select the required tab provided in the “Editing of Mesh” option that opened from the 
[Mesh] panel on the left side of the window as shown below. 

Each tab, the “Slope Surface Elevation”, “Sliding Surface Elevation”, and “Sliding Mass Thickness”, 
displays the Mesh Data topography. We can edit the following options for each tab.  

Note: If the drawing option from toolbar changed, the drawing may not be consistent with the tabs 

  

 
Item Description

Header Notation  The header notation on the mesh item stated as mesh number or 
represent as the X-Y coordinate values 

Selection of input-data type Choose from the following list of data types to edit: 
○ Slope Surface Elevation and Sliding Surface Elevation 

○ Slope Surface Elevation and Sliding Mass Thickness 
○ Sliding Surface Elevation and Sliding Mass Thickness 

(Note: It is impossible to load and edit the text file if parameters 
other than those listed above are modified)  

Creation of sliding surface By clicking this button, the sliding surface can be created by 
setting the Ellipsoidal body or by filling/excavation.  
 

Polygon area editing By clicking the button below, ON or OFF condition can be chosen.

  
When ON is selected, we can create the any-shape area by using 

left click while pressing the keys [Ctrl] + [Shift]. 
  

“Set in selected rectangle” 

button 
First, input the value of elevation in the blank box beside the 
button of “Set in selected rectangle”. Then, choose the objective 

mesh area. Finally, click the button of “Set in selected rectangle”. 
As a result, the same values of elevation will be set for all the 
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mesh that selected (this can save the time if we want to input the 

same elevation values in the mesh). 
 

If we use the “Polygon area editing” button clicked as ON mode, 
we can input the same value for any-shape area that have been 

created. In the case of OFF mode, it will be assigned the same 
value for selected cell blocks.  

 
If we click the “Polygon area editing” button to choose any-shape area, the figure below can be seen 

as an example. If we right click on the windows of 3D-View, the pop-up menu will appear and we 
can delete the last one point or delete all area points. 
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Method to edit the selected polygon 

 
Example to edit the initial Polygon (triangle) area 

    

(Figure 1) 

 

[Ctrl] + [Shift] + left click the windows of 3D-View 
One area point is added to the initial triangle. 

 
(Figure 2) 

 

Right click the windows of 3D-View 
The pop-up menu will appear and the last editing point can be cancelled or all area points can be 

deleted. 

 

(Figure 3) 
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Multiple polygonal areas can be set using the polygon edit mode as follows, 

        

Several numbers of new polygon area can be added by clicking the button “Add” 
If we edit with this state, a new polygonal area can be carried out. 
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3.6. Creating the Possible Sliding Surface using the Ellipsoidal Parameter 
(Skip this section if not necessary) 

If the Mesh data of the Slope Surface is already created, we can build the Sliding Surface using the 

ellipsoidal parameter. 

Go to the [Edit] menu and select [Ellipsoid Sliding Surface setting]. 

Or select [Ellipsoid Sliding Surface setting] from the toolbar. 
Or by opening the “Editing of mesh” dialog, click [Creation of sliding surface] and choose [Create 

sliding surface with section profile of Ellipsoid]. 

This will display the dialog box for building the ellipsoidal sliding surface from the selected section.  

 

The following explains the steps to create the ellipsoidal sliding surface using this dialog box. 

(The Initial View) 
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(1) Setting the Longitudinal Section of the landslide 

We can create an ellipsoidal sliding surface by setting the longitudinal section of the landslide on 
the left side of this dialog box. Once we enter the starting and ending points, the corresponding 

longitudinal section will appear on the right side of the dialog box (we can also input the starting 
and the ending points by using a computer mouse). 

 

(2) Setting the Sliding Passing Points and the Center Point of Ellipsoid on the Longitudinal Section 
After setting the longitudinal section, we can set the passing points of the sliding surface. By 

setting the passing points, the crossing section which passes through the center of the passing 
points will appear. The left part of the screen will display the position information. When we enter 

the center point of the ellipsoid, the ellipsoid will be displayed on the longitudinal section. Crossing 
points between the cross section and the ellipsoid will appear. (Note: we may not see the ellipsoid 

even after entering its center point. In that case, adjust the location of the center point and the 
passing points. We can input the passing points and the center point using a computer mouse.) 
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(3) Setting the Sliding Passing Points and the Center Point of Ellipsoid on the Crossing Section 

Similar to the longitudinal section, we can also set the passing point and the center point of the 
ellipsoid on the crossing section. We can set the crossing point between the sliding surface, the slope, 

and the X-coordinate of the center point of the ellipsoid. The cross point of the two sections and the 
elevation of the center of ellipsoid are already determined on the crossing section.  

 
(4) If the subsection is necessary to make, we can create the ellipsoidal subsection by following steps 

(1) to (3). Configure the ellipsoid by adjusting its location through steps (1) to (4). Click “OK”, then 
the ellipsoidal sliding surface will be built. 
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Item Description

The current editing section We can create the sliding surface using “Main section” or “Sub 
section”. If there is only one sliding surface, select “Main section.” 

Select longitudinal section Set the landslide longitudinal section to create an ellipsoidal 
sliding surface. After entering the starting point and the ending 
point of the longitudinal section, the corresponding image will 
appear. We can enter the data using a computer mouse.  

Resize option ○ Plane Figure ○ Longitudinal Section ○ Crossing Section 
Set an option to change the size of view windows when the size of 
the dialogue changed. In addition, when the “Section scale is same” 
is checked, cross-section will be displayed in the same aspect ratio.

Sliding Surface 
(longitudinal section) 
Passing points A, B, Center 

of Ellipsoid 
Sliding Surface 

(cross section) 
Passing points C, D, Center 

of Ellipsoid 

Set the passing points A and B which the sliding ellipsoid passes 
through and the center of the ellipsoid on the longitudinal section. 
After setting the passing points, the cross section which passes 
through the center of passing points will be displayed. We can enter 
this data using a computer mouse. Once the ellipsoid is created, the 
matched coordinates will appear on the crossing section. Similar to 
the longitudinal section, for the crossing section, set the passing 
points C and D which the ellipsoid passes through, and the center 
point of the ellipsoid (point D may be determined depending on the 
longitudinal section).  

 After entering the X-coordinate of the sliding surface passing point, 
input the Y-coordinate as “*” or by left-clicking while holding down 
the [Shift] key; the elevation of the slope surface corresponding 
X-coordinate will be automatically calculated.  

 

After creating the ellipsoid on the longitudinal and crossing sections, the appropriate ellipsoid will 
appear. We will see the region for the ellipsoid on the longitudinal section screen and the 3D view 

screen. The characteristics of the ellipsoid will appear on the dialog box 
 

Note: Coordinates are expressed as X’s along the crossing section, Y’s along the longitudinal section, 
and Z’s along the vertical direction. The X and Y coordinates on the longitudinal and the crossing 
sections represent the distances from the starting point of the sections and the Z coordinate 
represents the elevation. 

 

3.7. Filling and Excavating the Current Topography to Estimate Pre-failure Topography 
(Skip this section if not necessary) 

Once the mesh data of the slope surface is provided, we can create the sliding surface and the 

original topography before triggering land sliding by filling and excavating the current slope 
surface. To set the filling and excavation, follow the steps below. 

Go to the [Edit] menu and select [Recover (Source area/Deposition area)]. 
Or click the icon [Recovery (Source area/Deposition area)] from the toolbar. 

Or by opening the “Editing of mesh” dialog, click [Creation of sliding surface] and choose 
[Create sliding surface with recovery setting]. 

We will see the following dialog box.  
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Item  Description 

Delineate an area for modifying geographical features 

o Undo of setting [White] 
o Recover of Source area by filling [Yellow] 

o Recovery of Deposition area by excavation [Green] 
Set for all button 
 The filling and excavation attributes can be specified for each mesh data of 

the current geographical feature. If we click the button [Set for all] after 

selecting the mesh, the area will be updated by the selected attribute.  

Start recovery (Source area/Deposition area)
Direction of smoothing for recovery 
o Smooth elevation along X-axis 

o Smooth elevation along Y-axis 
Recalculation button 

 After deciding on the attribute, if we click the [Recalculation] button, the 
value of fluctuations from the current elevation of the geographical 
features will be calculated and appear on the mesh chart. (Note: if we 
change the direction of smoothing for recovery, the re-calculation may start 
automatically.) 
 
We can input the depth of mass arbitrarily. The input data will be valid 

until we re-calculate.  
 

Note: If we just change the attribute of the area, the re-calculation will not start.  
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Note: If we select the checkbox, “Input with a mouse,” and click the contour map, the cursor on the 
mesh chart will move. If we click the map while holding down the “Shift” key, the delineated area 
(created through undo of setting, recovery of source area by filling or recovery of deposition area by 
excavation) will be updated. We can also update the delineated area by clicking on a cell in the mesh 
chart.   
 
After finishing with all the settings, click [OK (Reflect topographical recovery)]. We will see the 

following final confirmation message. 

 
 

By clicking [OK] button, the recovery process will be executed based on the current settings, while 
clicking [Cancel] button will take us back to the previous settings dialog box.  

After running the recovery process, the slope surface of the current settings will become the sliding 
surface. The source area created by filling will become a new slope surface. If we only do the process 

of recovery of deposition area by excavation, the elevation of sliding surface and the slope surface 
will be the same. In this case, the range of the original slope surface will be deleted.  

 
About the Recovery Calculation 

The following shows the calculation of filling and excavation for an example elevation distribution.  

 

 
1 Calculation of the “Excavation” 
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If we select the entire section as the deposition area by excavation, the red dotted line will show the 

standard elevation line for excavation. If a mesh elevation value exceeds the standard line, the 
deposition area will be excavated up to the elevation of the standard line. Nothing will be done for 

the area below the standard line. 
 

2 Calculation of the “filling” 

 

If we select the entire section as the source area by filling, the blue dotted line will indicate the 
standard elevation line for filling. If a mesh elevation values falls below the standard line, the 

source area will be filled up to the elevation of the standard line. Nothing will be done for the area 
above the standard line. The geographical feature before filling will be a new sliding surface. The 

geographical feature after filling will be a new slope surface.  
 

3.8. Delineating Unstable Mass (Source area and Moving area) 

Once the geographical features of both the slope surface and the sliding surface are created, we will 

see the distribution of the unstable mass height. In the distribution, we can specify the delineation 
of elements such as “landslide source area” and “volume enlargement area.” 

To set the delineation of unstable mass, we can follow the steps below.  
Go to the [Edit] menu and select the [Delineation of unstable mass] option 

Or click the [Delineation of unstable mass] icon from the toolbar. 

When we click the tab “Delineating unstable mass” at the “1: Mesh” of the “Flow” panel on the left 

side of the window, the following dialog panel “Editing of mesh” will be displayed.  
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Item Description

Set landslide source area  
(red) 
Set volume enlargement area 
(blue) 

 

Clicking this button will set the selected range on the height 
distribution mesh of the delineation of unstable mass to either 
“landslide source area” or “volume enlargement area”.  

Cancel setting Clicking this button will cancel the selected range on the height 
distribution mesh of the delineation of unstable mass.  
 

Polygon area editing By clicking the button below, either ON or OFF can be activated. 

  
When ON is chosen, we can create the any-shape area by using 

left click and pushing the keys of [Ctrl]+[Shift].  

Modify setting including an 
area of depth (0 m)  

If we select this checkbox, we can set an area which does not 
contribute to the depth of the unstable mass (cannot specify this 
area by default).  

 

Note: This area setting is effective for performing “Initiation + Motion + Expansion Simulation”  
 

After finishing with the settings, click [Set completed] to close the dialog box. When the process is 
completed, we can see the mass distribution in the elevation edit area as follows, 
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4. Parameters and Conditions for Simulation 
 
After creating the mesh data representing the geographical features of the slope surface and the 

sliding surface, we need to configure the necessary settings for simulation. 
 

4.1. Setting the Soil Parameters 
 

Soil parameters are set for every mesh by following steps, 

Go to the [Parameters] menu, select [Setting the soil parameters], and choose [Input for each 

mesh]. Or click the [Soil Parameter] icon from the toolbar. 

When we click the “Soil Parameters” option at the “2: Calculation condition” of the “Flow” panel on 

the left side of the window, the following dialog box of “Editing of mesh” will be displayed. 

  

 
The “*” in the Edit column indicates the current parameter of being edited. We do not need to enter 

the data for the gray colored items. 
If we press the keys [Ctrl]+[Shift] and left click on the 3D-View window, the corresponding mesh cell 

in red color will be viewed in the window for mesh editing.  
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Item  Description

Editing items for 
parameters of soil 
characteristics 

Set the parameters for different grid points.
 

  
Polygon area editing By clicking the button below, either ON or OFF can be activated. 

  
When ON is chosen, we can create the any-shape area by using left 

click while pressing the keys [Ctrl]+[Shift].  

“Set in selected rectangle” 
button 

First, we input the value of elevation in the blank box beside the 
button of “Set in selected rectangle”. Then, choose the objective mesh 

area. Finally, click the button of “Set in selected rectangle”. As a 
result, the same values of elevation will be set for all the meshes we 

selected (this can save the time if we want to input the same elevation 
values in the meshes). 

If we have activated the “Polygon area editing” button in ON mode, 
we can input the same value for any-shape area that already created. 

In the case of OFF mode, it will be assigned the same value for 
selected cell blocks. 

About parameters of soil 
characteristics button 
 

Open the description dialog box about the parameters of the soil 
characteristics.  

 
The following table provides seven parameters that can be set for different grid points. 

Item Symbol (Unit)  
Lateral pressure ratio k ○ 
Friction coefficient inside landslide mass tan ϕi ○ 
Friction coefficient during motion at sliding surface  tan ϕm ○ 
Steady state shear resistance at sliding surface ss (kPa) ○ 
Rate of excess pore-pressure generation Bss ○ 
Peak friction coefficient at sliding surface tan ϕp 

Peak cohesion at sliding surface cp (kPa)  

Unit weight of mass  (kN/m3) ○ 

Symbol “○” represents the required items, while “” represents the required items for considering 
the strength reduction for the “Initiation + Motion + Expansion Simulation.”  

 
 

 

  



 

 
 

31

4.2. Conditions for Calculation  
 
In the LS-RAPID system, we can set various patterns for landslides simulation. 

Go to the [Parameters] menu and select [Condition for calculation]. 
Or by clicking the “Conditions for calculation” option at the “2: Calculation condition” of the “Flow” 

panel on the left side of the window, the following dialog box of “Set condition for calculation 
(Landslide)” will be displayed. 

  

  
 
Item  Description

Condition of the simulation   Select the simulation type that we would like to perform. 
(Motion simulation) 
○ Motion simulation 

(Full mode simulation: Initiation + Motion + Expansion) 
○ Normal simulation  
○ Seismic simulation  
○ Rainfall simulation 

 
□ With pore pressure 
If we choose the “With pore pressure” box, pore water pressure 

will be considered as landslide trigger (Only when selecting 
Seismic simulation. Time of heavy rainfall is required). 
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◆Seismic simulation 
Item  Description 

Seismic loading (K) Set the seismic loading force as an inducement of the landslide. We can set a 
constant seismic load or a fluctuating seismic load over time. We can choose 
one of the following seismic operation methods. 
○ Static  ○ Cyclic  ○ Seismic 
In the Static method, the seismic coefficient varies linearly.   
In the Cyclic method, the seismic coefficient varies as a sine wave while the 

value of the amplitude changes linearly.   
In the Seismic method, the seismic coefficient varies based on the actual 

seismic wave form data.  

Edition of seismic 
waveform button 

If the seismic method is selected, we need actual seismic wave data. By 

clicking this button, the dialog box can be seen for editing the waveform 
data.  

Substitute the 
direction of 
landslide profile 
button 
 

By clicking this button, if we created the sliding surface (in the main 
section) from an ellipsoid, the direction of the land sliding longitudinal 
section will be set as the seismic direction.  
 

<Example of settings> 
(1) Static Method 

  

The above Static setting will cause the seismic coefficient to go up from K=0 at the beginning of the 

simulation to Kmax in four seconds and it will remain fixed for thirty seconds. 

(2) Cyclic Method 

  

The above Cyclic setting will cause the amplitude of the seismic coefficient to go up from K=0 at the 

beginning of the simulation to Kmax in three seconds (=6/2Hz) and it will remain fixed for fifteen 
seconds (=30/2Hz). 
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(3) Seismic Method 

  

The above Seismic setting will cause the seismic coefficient to become Kmax=0.15 based on the 
edited seismic waveform. We can set the value of “Kmax” for the seismic coefficient in the 

X-direction, Y-direction, and the Vertical direction (Note: see more details about the editing of the 
seismic waveform in the next section) 

In addition, when conducting a Seismic simulation, if we choose “With Pore Pressure”, pore 
pressure can also be considered to be a factor to trigger landslide. 
 
Item Description 

Water pressure  
(pore pressure ratio: ru) 
 (ru = u/… 0.0 ～1.0) 

Setting the pore pressure as a factor to trigger landslide. Pore-water 
pressure can be set as a constant value or variable value changing 

with time. The start time can also be set. 
 

 The pore pressure can be set as: 
○ Static  ○ Survey 

In case of Static, the pore pressure will be constant. 
In case of Survey, the monitored data of pore pressure can be used. 

Input pore pressure: ru If we select Survey as an operating method, it is necessary to input 

actual data of pore pressure. After clicking this button, we can edit ru 
in the editing dialog of pore pressure data. 

 
<Example of settings> 

 (1) Static Method 

 
The above setting means that the pore pressure will go up from ru = 0.0 at the beginning of the 
simulation to ru = 0.4 in three seconds and remain fixed for seventy seconds. 
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(2) Survey Method 

 

 
Item Description 

Calculation Time Unit (Initiation period) 
Calculation pitch 

Velocity limit 

This button is to set the landslide velocity faster than the planned 

velocity for each calculation step, when it is not yet reach the velocity 
limit. 

Monitored value of ru Input the pore pressure ratio (ru) 

 
◆ About the simulation in heavy rainfall 

Item Description 

Input rainfall data 

 

Input the rainfall data as the factor to trigger landslide. Input unit is mm/10 

min. By clicking this button, we can edit rainfall data. 

 
 

Setting of pore pressure ratio is necessary for the simulation of rain-induced landslides.  

To estimate the pore pressure ratio from the rainfall record, we can refer to “3.Estimation from the 
rainfall record to the pore pressure ratio of the Theoretical Background of LS-RAPID”. 
 
◆Parameters of condition for strength reduction 
Item  Description

Parameters of condition for 
strength reduction 
Source area 
(by travel length) 

In the (Initiation + Motion + Expansion) simulation mode, the 
simulation will reduce the friction coefficient and the cohesion 
from their peak values to the normal motion time values within 
the source area in the determined distribution of the unstable 
mass (reducing from “tan ϕp” to “tan ϕm“ and from “cp” to “cm”). 
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Note: Essentially, when the travel length becomes DL (mm), the 
reduction will be started. Once the travel length reaches DU 
(mm), the reduction will be completed and then normal motion 
simulation will start. 
 

Parameters of condition for 
strength reduction 
Except source area 
(by depth of mass) 

In the (Initiation + Motion + Expansion) simulation mode, the 
simulation will reduce the friction coefficient and the cohesion 
from their peak values to the normal motion time values within 
the source area in the determined distribution of the unstable 
mass (reducing from “tan ϕp” to “tan ϕm“ and from “cp” to “cm”). 
Note: Essentially, when the depth of mass reaches ⊿hcr (m), the 
reduction will be completed and the normal motion simulation 
will start. 

 
◆ Setting of the submergence calculation 

Item  Description 

Calculate submergence When choose this button, the soil mass under the water will be 
considered as buoyancy. 

(example : the simulation of submarine landslide) 

Level of the water surface Set the depth of the interface between the submerged and 

non-submerged soil mass. 

Unit weight of water Set the unit volume weight of water 
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4.3. Registration of Seismic Waveform 
 
In the landslide simulation, we can set the seismic waveform based on the model seismic waveform 

as well as actual observation data by the initiation simulation of inducement of seismic loading. The 
following section describes steps for setting the seismic waveform based on actual observed data. 

To start editing, we need to select the Seismic method in the previous section, “Condition of 
calculation”, and click [Edition of seismic waveform]. Or go to the [Parameters] menu and select 

[Registration of seismic waveform]. The following window will be displayed.  

 

Here, we can register three observational cases. In the actual simulation, we can select one of these 

cases and start the calculation. For each case, enter a name for the data-set in the top box and enter 
the values of the observation times and the acceleration K (unit: Gal) in the appropriate columns.   

 
<Things to Note before Entering the Data> 

1. Enter the observation time in chronological order. 
2. When entering the seismic coefficient, the EW means the X-direction and NS means the 

Y-direction.  
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4.4. Setting Time Step 
 
In the landslides simulation, we can adjust the motion process degree using a specified time step.  

Go to the [Parameters] menu and select [Set time step]. 

Or by clicking the “Setting time step” option at the “2: Calculation condition” of the “Flow” panel 

on the left side of the window, the following dialog box of “Setting time step” will be displayed. 

  

 
Item Description

Calculate with a definite time 
step in the whole process 
 

By selecting this checkbox, the simulation time step will 
remain constant as the simulation proceeds.  

Initial time step (DT1) Set the time step for the first step of the simulation.  
 

Upper bound value of time step 
 

If the next time step calculated from the average maximal 
velocity v= 2

max
2

max vu   is more than the entered value, set 

the next time step to the value entered here. 
 

Number of calculations per mesh 
(N) 

Set the number of calculations by mesh N where the next time 
step is defined by dx(=mesh pitch)/N/v. 

Number of calculations (M) to 
reach the terminating distance of 
reduction of shear resistance 
(DU) 
 

Set the number of calculations M to define the time step by 
DU/M/v in the parameters of the initial simulation. After 
reaching the terminating distance of reduction of shear 
resistance, the simulation proceeds with the time step of the 
motion simulation. 
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4.5. Setting Other Conditions 
 
This section explains the system’s less-frequently used simulation settings.  

Go to the [Parameters] menu and select [Set other conditions]. 

Or by clicking “Setting other conditions” option at the “2: Calculation condition” of the “Flow” 

panel on the left side of the window, the following dialog box of “Setting other conditions” will be 
displayed. 

  
 
 
◆Non-frictional energy consumption 

 
Item  Description

Trigger non-frictional energy 
loss function 

By checking this box, the non-frictional energy consumption 
(=α*1/2*m*v2) will be considered in the simulation. 

Coefficient α This is the coefficient (α) for the simulation when triggering the 
non-frictional energy loss function. 
 

Introduction by velocity 
Introduction by depth of mass 

By checking this box, the non-frictional energy consumption 
(=α*1/2*m*v2) will be considered, corresponding to the mesh 
which reaches the specified velocity (depth of mass). 
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◆Other settings 
Item Description

Threshold of flow rate 
(neglected below this value) 

The threshold of flow rate is the minimum amount the soil is 
moving in the calculated mesh within the unit time. The unit is 
m3/sec. In the case of landslide, the “mm” unit landslide is thinner 
than water; therefore, the landslide cannot usually flow. Thus, if 
the flow rate goes below threshold, the mesh does not accept the 
flow. The value depends on the size of the landslides, but ~0.01 
m3/sec can be used as the first approximation for usual landslides 
 

Calculate the case of crossing 
over a ridge 

When the landslide mass travels down a curved torrent, most of it 
travels along the torrent. However, there is a case in which the 
upper part of the landslide mass, if it is higher than the ridge, 
goes over the ridge. If we would like to include this effect in the 
simulation, select the checkbox or deselect it if not necessary 
(there is no harm in leaving the checkbox selected whether there 
is a case of crossing over the ridge or not).  
 

Calculate increased lateral 
pressure at vertical 
earthquake loading 

As we can see in “Explanation of Section” 1.1., three seismic stress 
factors are considered in the simulation. When the vertical stress 
is increased, the lateral stress should be increased accordingly to 
the lateral pressure coefficient (the ratio between the vertical 
pressure and the lateral pressure). If we concerned about this 
effect, select this checkbox, if not then deselect the checkbox (the 
checkbox should be selected under normal conditions). 

Cohesion inside mass 
(Ci・kPa) 

Set the cohesion inside mass for all the geographical features. 

Cohesion at sliding surface 
during motion  
(Cm・kPa) 

Set the cohesion at sliding surface during motion for all the 
geographical features. 

Calibration parameter of 

calculated landslide mass 
- Target velocity of 

calibration 
- Start calibration from 

initial mass 

In general, the total volume of soil mass does not change during 

simulation. However, the volume is possible to increase when 
calculation reach unsteady situation. In this case, we can adjust 

the velocity by increasing x % of the velocity before simulation. 
 

 

Note: The ranges listed beside “Ci” and “Cm” in the dialog box represents typical values. 
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5. Run Simulation  
 
This section describes the output settings for the landslide simulation.   

 

5.1. Output Settings for the Landslide Simulation  
 

When we click the “Set calculation output” option at the “3: Simulation” of the “Flow” panel on the 

left side of the window, the following dialog box of the “Output setting” will be displayed. 
 

  
 
◆Calculation step numbers (for result drawing and saving) 

 
Item Description

Calculation step numbers  
(for result drawing and saving) 

Set the number of the calculation steps 

Maximum step Set the maximum step

Drawing interval 
o By calc. step 

o By calc. time (sec) 

Set the time interval for updating the geographical features 
during the simulation. The intermediate simulation results 
will be saved in the output files at the end of each time 
interval. 

Necessary number of samplings 
to display, Umax, Vmax 

 

The number of samples of the velocity per mesh in order to 
display the X and Y components of the maximal velocity 
during the simulation (the displayed velocity values for each 
mesh are the average over the samples. 

Minimum time for simulation Essentially, the simulation will be finished when all the solid 
features are stopped. However, if we set the minimum time, 
the simulation will run until the end of the entered time, even 
if all the solids have stopped. 
 

How to display calculation time We can choose calculation time in second or in hour. 
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Item Description

Comments field Enter any comments that would like to be displayed during 
simulation. 

Drawing period of landslide 
trigger 

When conduct a simulation under earthquake or heavy 
rainfall, the graphs can be displayed together to compare 
them. The length of time axis can be set. 

 

◆ Output the altitude information 
Item Description 

Outputs the altitude 
calculation result data 

If this column checked, the resulted calculation of elevation data 
after simulation is an output that will be stored into a same 

folder as the project file located. 

In the output options, we can set the display updating interval 
as“passed time”. 
※ the output file can be the examples as below: 

(when set the output interval as 1.0 second) 
G0000120.dat: the ground surface altitude after 12.0 seconds 

M0000120.dat: the altitude difference between the 12th second 
and 11th second. 

(= “G0000120.dat” - “G0000110.dat”) 

No refresh view during 3D 

calculation 

If we choose this option, the 3D view will not be refreshed in 

calculation. The display time will be somehow shortened. 

Waiting time for drawing 

altitude data 

If we want to view the results with conducting the simulation, 

we can use this button to read the outputted altitude data.  
The waiting time can be set if we want to view the results 

earlier. 
 

◆ Output options 
(Options here is different with the above “Output the altitude information”) 

Item  Descriptions  

Assign the head words for 

output files 

We can set the head words for output files and folders 

Step range to output 
calculation result 

We can output the data in a range 
(As default, all data from the beginning will be outputted ) 

Text files Here, the following files can be outputted: 
VALUE … Depth of unstable soil mass for each mesh 

GRAPH … Using graph to display the depth of unstable soil 

mass for each mesh 
U, V, UV Bar …Velocity of soil mass for each mesh 
(U: X direction、V: Y direction、UV Bar: mean value) 
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Delimiter 

(when output the text) 

○ Space  ○ Comma 

Setting the text between the values 

Output Digit 
(when output the depth of soil 

mass) 

○ integer  ○ 0.1 unit  ○ 0.01 unit 

Choose the unit for the depth of soil mass 

Output Form 
(when output the depth of soil 

mass) 

○ Matrix  ○ Control Point Form 

When give an output for the soil depth, we can display them as 

matrix or control point form (output the depth for each mesh ID 
and soil mass depth in a row) 

Picture clipping area 

(when output the images) 

○ Application area  ○ 3D-View area 

We can select the application area or choose the interested area 
from 3D display and then create them as JPEG image and AVI 

animation files. (In case the JPEG image cannot be displayed 
normally, we can choose 3D-View area) 
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5.2. Start Simulation 
 
Click from “Flow” panel  then [3: Simulation] option  and choose [Start simulation].  

Or by clicking the [Execute] menu and select [Start Simulation], 
Or click the [Start Simulation] icon “fx” directly from the toolbar to begin the simulation.  

 

   

The following figures are the captured screens during simulation as examples 

 
(Left: an illustration of the ellipsoid) (Right: an illustration of the mass thickness 

expanded two times) 
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5.3. Commands during the Simulation 
 
We can run the following commands during the simulation.  

 

 Calculation monitoring 
Opens a dialog box showing the mass thickness and the values of 
different components of the velocity 

 Given triggering factors  
Opens a dialog box showing the pore pressure and seismic loading and 
rainfall 

 Pause Pauses the simulation temporarily   

 Restart  Restarts the simulation which has been paused temporarily 

 Stop  Forces the simulation to stop 

Note: Both the “Calculation monitoring” and “Given triggering factors” commands can also be called 
from the [View] menu by selecting [Display of calculation values]. 

 
5.4. Display the simulation results 
  
If we have selected the “Output of altitude information” in the setting of simulation output 

(described in the above Section 5-1), we can read and display the outputted altitude data when we 
run the simulation. 

Click from the “Flow” panel on the left side of the window  then choose [3: Simulation]  and 
select the [Result of simulation], 

Or by clicking the “Execute” from Menu and choose “Display the simulation results”. 

Otherwise, we can directly select the icon “Result Display” to display the simulation results. 
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6. Other Commands 
This section explains other commands which have not been mention in the previous sections.  
 

(1) The [File] menu 
Menu Item Description

New Creates a new data file for the landslide simulation system 

Open Opens a data file 

Save Saves the data file 

Save as Saves the document as a different file. Choose the new file name and 
location for the document 

Read text data file 
The text data files (Control Point, Mesh Data) can be read. The tool 
transferring Control Point to Mesh Data is also prepared here 

Write to a Text Data 
Export the entered numerical values（Control Point、Mesh Data、
Parameters of Soil Characteristics）to a text data file 

Setting background image 
file Setting the image files which can be pasted to the background 

Save image by JPEG Saves the image currently displayed in the 3D view as a JPEG file  

Close of File Close the editing file 

Exit of Application Exit 

 
Note: There are two options under the “Write to a Text Data” item in [File] menu, namely, “All Data” 

and “Specific Data”. If we choose the “All Data” option, all values will be exported to a text file. We 
need to specify the location of the exported file the same way as we did for the simulation output 

file under the “assign the head words for output files” in the “output setting” dialog box (Section 
4-6). If we choose the “Specific Data” option, we have to select the value to be exported from the list 

that will show up, and then select the location of the exported file and save it. 
 

About the “Setting background image file” 
 After we choose this menu, we can paste the selected image to the background. 

Opening the dialogue of Setting Background Image File, we may choose the objective file by 
clicking the [Select file] button. From the image preview window, we can select the interested area. 

When we want to remove it, just click the [Remove file] button. In addition, only BMP and JPEG 
files can be selected. 

After the files are chosen, we may set the position where the selected image located in the 
simulation area. As defaults, the image’s triangular positions are exactly same with the simulation 

area’s triangular positions. 
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(2) The [View] menu 

Menu Item Description 

Setting the View Point of 
Topography 

Update the viewpoint by setting the angle of rotation for each axis. 
We can update the viewpoint of the screen by using a mouse  

Reset geographical viewpoint Reset the topography viewpoint to the default setting 

Reset geographical feature  Reset the topography data that has been previously calculated 

Setting of Topography View Setting of topography view 

Setting of Topography Color Setting of topography color and contour 

Current Figure 

Select the topography that we would like to see from the following 
list 
○ Slope surface・Sliding surface (Default) 

○ Thickness of Sliding mass 
○ The Last View of Calculation 

○ Sliding Mass Thickness distribution 

View Cross or Longitudinal 
Section View the cross section at the selected location. 

Output arbitrary section 
profile 

Set the output section arbitrarily. We can do output for the section 
coordinates. 

Display of calculation 
values 

Display the value of each mesh data during the simulation. In 
“landslide inducement parameter”, the values indicate the pore 
pressure and the seismic loading for the initial simulation. 
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”Setting the view point of topography” 

From this menu, we can use the following dialogue to set the parameters which are needed to set 
the viewpoints of topography.  

 

In this dialogue, we may set parameters of Zoom Position (X, Y, Z), Zoom Ratio, Rotation Angle (X, 
Y, Z axis・degree unit). If we want to save the desired view points or to fix some view points, we 

may register the maximum 5 view points by click the button of Registration. When we want to use 

the registered view point, just select the row and then click the button [Adoption]. 
 

About the “Setting of Topography View” Menu 
Once we select this menu, the following dialog box will appear to set the topography view as 

necessary. 
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Item Description

Draw control point The software will display the control point if any. 

Draw lines of mesh The software will display the grid lines. We can specify the 
step interval. 
 

Draw contour lines The software will display the contour lines. We can also 
specify the interval. 
 

Draw base elevation Draw the base of elevation. 

Draw axis-grid Draw an axis of coordinates. 

Draw topography in 2-dimension 
 

Draw the topography in two-dimensions. 

Surface displaying without 
Luster 

Check this item if the topography does not show up in the 3D 
view (this setting is usually unnecessary). 

Emphasis extent of altitude If we want to emphasize the altitude compared to the real 
ones, we may type the emphasis extent value here. 

Topography view while 
calculation 

Select one from the list below:
o Depict a cell of mass as a ball 
o Draw topography with ordinary style  
o Draw as a mesh distribution  

Mass zoom up When we select either “Draw topography with ordinary style” 
or “Draw as mesh distribution”, we can display the 
topography by customizing the zoom level of the mass. 

Ball position If we choose [Depict a cell of mass as ball], we can set the 
standard radius and altitude addition. Generally, they are set 
automatically.  
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Item Description

Mass/depicting color of block line  

Critical velocity to change ball 
color Vcr 

Sets the critical velocity (Vcr) at which the stable mass 
changes to a moving mass. 
 

Threshold height to show sliding 
mass 

Displays a mass depth greater than the specified value as 
“sliding mass”. 
  

Color gradation to depict depth of 
mass 
Color gradation to depict 
expanding area 

Sets the color gradient to depict the depth of the mass when 
describing the moving mass and the stable mass by an 
ellipsoid or a mesh. 

Color of block line Displays the block line for showing the simulated sliding mass 
distribution area and for the landslide mass in the source area 
of the motion simulation. 
 

Color Default Return to the initial default values
 

 
※ If we want to depict the color of mass, just double click the “Color” palette or hexagon and 

change the color.  
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About the “Setting for Topography Color” Menu 

After select this menu, the following dialog box will appear. We can set the topography view as 
necessary. 

 

 

Item Description 

Default Color 

(Pattern A, B) 

Set the color using the default patterns. Pattern A is mainly used 

for sub-aerial landslides, and Pattern B is mainly used for 
sub-marine landslides. 

Color of Topography We can set the color according the elevation of topography by 

clicking the triangle on the left side of color palette. On the right 
side, input the elevation ratio (0.0-1.0) according the color that we 

have specified. 
Harmonize Color 

(Top-Bottom /  
Top-Middle-Bottom) 

To adjust the color between the ranges. ”Top Bottom” is to 

harmonize the color between Top and Bottom color. ”Top Middle 
Bottom” is to harmonize the color between Top and Middle, and 

Bottom color. 
Color of Horizontal Plane Set the color/level/permeability for some topographic surface. If we 

wish to run the submarine landslide simulation, we can define the 
water surface here. 

Color Contrast of Contour When we want to depict contours, we can set the interval, color, 
thickness, horizontal option of the contour lines here. 

Other coloring factors  

Choice area line Set the color for the objective area we have selected by lines. 

3D-view background Setting the 3D-view background 
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Item Description 

Light source  

Position When displaying the altitude in 3D view, we may select the 
position of light source, even though we can use default values. 

Quantity This option is to set the parameters of light quantity. The Ambient 
or Diffuse light can be selected. Ambient light is used to set the 

light for entire ground altitude. Diffuse light is used to set the 
light from light source, which is similar to sport light.  
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About the “View Cross or Longitudinal Section” Menu 

In this menu, the cross sections parallel to the X and Y axis can be viewed as shown in the dialogue 
box below. In the default colors, the green means slope surface; the red means sliding surface; the 

pink means the section of the slope surface after simulation.  

If we click “information”, the dialogue of “information of sections” will appear and we can define the 

color and thick of the cross sections. 

If we select the “Locate Y-Section Above” checkbox, the order of the section will be displayed 

reversely. 
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About the “Output of arbitrary section profile” Menu 

By selecting this item, the following window is shown where we can set the section layout as 
necessary.  

 

 
Item  Description

Layout of cross section  Enter the starting and ending points of the cross section that 
we would like to display. We can enter the data by using a 
computer mouse.  
 

Cross section profile Displays the cross section profile based on the specified values 
of the section coordinates.  
 

List of cross section coordinate Displays the coordinate values of the cross sections of slope 
surface and sliding surface corresponding to the above cross 
section profile. 
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(3) The [Parameters] menu (System environmental setting) 

 
This menu is used for the basic settings of the LS-RAPID model. 

 

 
 

Item Description 

Skip the Opening Title As default, the introduction window of LS-RAPID will appear 

when it is started. 

3D-view is not moved with a 

mouse during simulation 
calculation 

If we select this option, nothing will happen when we click or 

drag the mouse during the simulation. This function can be 
used in case the topography suddenly starts to move.  

Value “0.0” is displayed by default 
in calculation result dialog 

In the dialogue of the calculation result, we can choose 
whether the value of 0.0 will not be displayed. Generally, it 

will not be displayed when we started the LS-RAPID. When 
we checked this button, value “0.0” will be displayed in the 

calculation result.  
 

(4) The [Help] menu 
Menu Item Description

Help Displays the help for the software 

Explanations of LS-RAPID Describes the following concepts in the LS-RAPID simulator. 

Control guide Explains how to move the screen using a computer mouse 

Check update We can check whether the “LS-RAPID” is the latest version or not by 
connecting through the internet. 

Version information Displays the version of the LS-RAPID software 
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(5) Toolbar Commands 

The LS-RAPID system uses the following toolbar commands  
(The icons are described from left to right). 

 

 

Icon Description 

New Create a new text file 

Open Open a data file 

Save Save the current data file 

Simulation area 
setting The necessary initial settings to display the topography 

Ellipsoid sliding 
surface setting Edit the sliding surface and the section from the ellipsoid 

Filling and 
Excavating Filling and excavating the current topography 

Delineating 
Unstable Mass 

Delineating source area and volume enlargement area 

Topography View Setting of topography view 

Topography Color Setting of topography color and contour 

View Cross Section Display a section of the topography cut parallel to the X-axis and the Y-axis. 

Geometry Style Choose the topography to be displayed (the slope surface or the sliding 
surface)  

Thick Area Choose the topography to be displayed (The distribution of the depth of the 
unstable mass) 

Calc. Result Choose the topography to be displayed (The screen of the final calculation 
results)  

Calc. Thick Choose the topography to be displayed (The distribution of the mass after 
the calculation is done) 

Soil Parameter Set parameters of soils and pore pressure 

Start Simulation Start the simulation  

Result Display Display the calculation result 

Calculation 
monitoring 

Open the dialog box showing the mass thickness and the values of different 
components of the velocity 

Given triggering 
factors Open the dialog box showing the pore pressure and seismic loading 

Pause Pause the simulation temporarily   

Restart Restart the simulation which has been paused temporarily 

Stop Force the simulation to stop 

Help Display the help for the software 

Guidance of Graph 
View Explain how to move the screen with a computer mouse 
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(6) Command for Display Pane 

This command is about the display setting of 3D view in the screen. 

 

Item Description 

Axis line 
(Coordinate axis) 

Display the axis coordinate 

Contour 

(Contour line) 
Display the lines of contour 

Lines of mesh 

(Grid line) 

Display of the grid lines. We can specify the grid line spacing 

through the "Display setting" screen 

2D display Displayed as the 2D form 

Base elevation 

(Horizontal plane) 
Display of the horizontal plane 

Unstable mass 
(Display of unstable soil 

mass) 

When this option is selected, the unstable soil mass are represented 
by spheres according to the thickness in the case of the “Surface” / 

“Sliding surface” drawing mode. 

Field 
(Landform) 

We can select whether to draw the ground surface by selecting the 
item “Surface” or slip surface through the “Sliding surface” drawing 

mode. It is linked with the tab on "Mesh edit" display. 

Mass expression the 

simulation results 
(Soil mass displayed from 

calculation result) 

The same command as the "Topography view while calculation" on 
the "Setting of Topography View" display. 

Ball (Sphere) Soil-mass is drawn with spheres. 

Normal Landform is drawn in normal. 

Mesh (Sliding surface) Soil mass is drawn in the distribution of each mesh. 

Stable mass 
(Display of stable soil mass) 

The stable soil mass is drawn. 

 


